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Introduction
During a course on Irish paleography we discussed the description of hands, how hands were

differentiated from one another. It turned out to be quite vague and subjective, and terms like
‘slightly less angularity’l, ‘rather large looped stem’? and ‘somewhat smoother’ were used.
At the moment, in our digital world, it must be possible to come up with more objective
results. If you can analyze a manuscript with the aid of a computer, you can come up with
criteria, which, when applied consistently across all the manuscripts, are more objective than
the traditional way of describing hands. As far as | know, no one has looked at which
computer programs are currently available with respect to their usefulness for Irish
manuscripts. Therefore, in this BA thesis, | investigate this problem. That is, | examine which
programs are available at the moment and explore how they can be used by paleographers

working with Irish manuscripts.

' 6 Concheanainn 1973: p.160
2 ® Concheanainn 1973: p.161
*> ® Concheanainn 1973: p.165
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Methodology, Theoretical Background and Research Question
For this BA thesis | take the same approach that Mark Aussems took with his dissertation

‘Christine de Pizan: The Scribal Fingerprint’. The first step is to see which computer
programs are being used by paleographers and what those programs do; the main focus is on
GIWIS (Groningen Intelligent Writer Identification System), Graphoskop and GIMP (GNU
Image Manipulation Program). The second step is to examine how hands are described
traditionally and which differentiators are used. After that | combine the first two steps to
explore which of those differentiators can also be measured by a computer program, thereby
also looking at the differentiators used by other paleographers outside the field of Celtic
Studies who work with those computer programs, for example Mark Aussems, who worked
with French Manuscripts and Jenna Smit, who used GIWIS with her study of the chancery of
the counts of Holland (1299-1345). Further, the technical requirements of the images will be
determined, for example: how large do they need to be in order yield good results? Many Irish
manuscripts have been made available via the Irish Script On Screen project, where images
(JPEG) of the manuscripts in normal quality (20% scaled version of the original, 200-400 KB)
are accessible to all and after registration the high quality images (full-size, up to 5MB) can
be accessed”. Is the quality high enough or in order to get good results do we need to use the
original scans (TIFF)? The final step is to determine which of the programs are best suited for
on Irish manuscripts. | use Lebor na hUidre as a ‘test case’, since it was written by three
hands® and is digitally available via the 1SOS project Additionally, since the results of
measurements can be expected to differ for each hand, the manuscript can therefore be used to
distinguish which programs or differentiators are useful for Irish manuscripts. The
methodology which | use for that part of the thesis can be found in the chapter on Lebor na
hUidre. To summarize, the research questions for my thesis consists of the following:

Main question:

Can the computer programs which are currently available to the paleographer help to identify
different hands in Irish Manuscripts?

Sub questions:

- Which computer programs are available at the moment and what can they do?

- How are the hands traditionally described and which differentiators are used?

* http://www.isos.dias.ie/english/index.html > Technical
> Best and Bergin 1929: p. xiii
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- Which of those differentiators can also be measured by the computer programs?
o Do we need to come up with new differentiators?
o Which differentiators do other paleographers use when using these programs?
Can they also be used for Irish manuscripts?
o What is required of the images of the manuscripts (size, distance to camera,
etc.)?
- When using the programs on Irish manuscripts, which are best to use?

- Test case: Lebor na hUidre



Computer Tools Currently Available
In recent years the interest in computer tools which can help identifying hands has grown

among paleographers, but also some reluctance can be seen.® Some researchers, such as Peter
Stokes, Mark Aussems, Axel Brink and Jenna Smit have published articles about these

programs in the last decade, | will use them as a basis in the search for useful computer tools.

The first program | want to discuss is GIMP (GNU Image Manipulation Program), which can
be downloaded and used by anyone. GIMP has a measuring tool with which distances and
angles can be measured. It was not developed for the use of paleographers, but as its name
says it is an Image Manipulation Program in general. Although with GIMP the angle of
inclination can be measured, the user needs to put the angle-measurement tool in the right
place and draw the angle himself. GIMP is used by Mark Aussems for what he has named
“The Scribal Fingerprint’’. In his research he measures the angle of inclination and the minim
height, for this GIMP seems very useful. In the traditional paleography this was done
manually which is very time consuming and difficult because not all the manuscripts can be
handled that intensively any longer because of their fragile state. With GIMP the manuscripts

and time can be spared.

The second tool is Graphoskop, which is a plug-in for ImageJ. The language in which the
plug-in is written is French, so in order to work with it some knowledge of the French
language is needed. It can measure much more than just angles and distances. But for this BA
thesis | will only look at measuring the angle of inclination. Graphoskop has a measuring tool
similar to GIMP, but will collect the results and show them in a different window. Mark
Aussems states in his dissertation the fact that Graphoskop might not give reliable results®, |
will take measurement with GIMP and Graphoskop to examine whether the results are close

together, if they are Graphoskop might be reliable when measuring the angle of inclination.

The third tool is GIWIS (Groningen Intelligent Writer Identification System), and
incorporated in GIWIS is Quill, which was especially designed by Axel Brink to use on
manuscripts written with quill and ink. GIWIS was originally designed to help forensic
researchers identifying modern hands in, for example, suicide notes. As has been done before

® peter Stokes mentioned in his article that ‘digital paleography’ received little acceptance and little interest
from ‘traditional’ paleographers.

7 Aussems (2011): 142. His definition of the term is: ‘The ultimate goal is to find a set of variables whose values,
taken together, will provide a characterization of a scribal hand that is valid only for the hand in question. This
set of variables will henceforth be called the Scibal Fingerprint.’

® Aussems (2011): 165
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with other medieval manuscripts, which came from the continent and were written in French
and Dutch, | test whether it can be of assistance for paleographers, who work with Irish
manuscripts, as well. One of the advantages of GIWIS is that multiple images can be placed

in a dataset in order to let GIWIS compare them, which makes it more independent of its user.



Describing Hands Traditionally
As already stated in the introduction, the describing of hands and identifying them is vague

and subjective. When done manually, it comes down to describing what is seen and including
some measurements done by hand. Sometimes a scribe has a special feature which sets him
apart from other scribes in the same or other manuscripts. For example the first hand in Lebor
na Huidre has a hooked open a which the other hands in this manuscript do not have. There
does not seem to be a uniform list of differentiators which are used when identifying hands in
Old Irish manuscripts. Most of the time the hands are described and compared in a way that
the researcher sees fit. One differentiator which is often used is language, looking at whether
older forms of Old Irish are used or newer developments can be found. It seems that the main
focus of researchers, regarding Old Irish manuscripts, is to make editions of the texts and
examine the language which is used. Even when they are working on the paleographical side
of a manuscript they tend to fall back on the subject, the Irish language, which they know very

well.

As said before, a uniform set of differentiators, which all can use to conduct research on
identifying hands in OIld Irish manuscripts, is not widely spread within the field of Celtic
Studies; however in the article of Elizabeth Duncan® one such list can be found which she

uses to analyze Lebor na hUidre. Her list consists of ten differentiators®:

- aspect, the overall appearance of the script

- ductus, the speed and direction of writing

- pen-angle, the angle at which the pen is held for writing

- weight, the ratio of the width of the pen-stroke in relation to its height

- letter-forms, an assessment of how individual letters are constructed and their variant
forms; an examination of ligatures and monograms

- mannerisms, an investigation of any particularly distinctive features or foibles in the
writing

- orthography, odd and unusual spellings

- abbreviations, odd or unusual abbreviations and their formation

- punctuation, an assessment of the types of marks of punctuation which are used and an

analysis consistency in practice

? Elizabeth Duncan discusses in her article the possibility that hand M is also the hand of a copy of Boethius’s
“De Re Arithmetica”, a Latin manuscript.
' buncan (2012): 5. Based on a list by M.P. Brown.
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- ‘textual apparatus’, idiosyncrasies in devices to assist layout and facilitate reading,

such as initials, line fillers etc.

Looking beyond Celtic Studies, the work of Jéan Mallon can be found, a Frenchman who was
one of the first to bring forward a set of differentiators which can be used to identify hands in

medieval manuscripts. His list consists of seven differentiators'**?:

- form, the morphology of the letter form

- writing angle, the position of the quill with regards to the base line

- ductus the way and order in which the strokes are applied to make a letter

- modulus, the dimensions of the letter forms

- contrast, the difference between the broad strokes and the hairline strokes

- writing support, for example in which environment the manuscript was written

- internal characteristics, the nature of the text, the composition of codicological units
and historical and philological data regarding the manuscript.

Based on these lists of differentiators a list must be made of differentiators which the
computer programs can measure. The angle of inclination®?, often mentioned as a part of
ductus, weight or contrast and modulus can be measured this way. The other differentiators
are useful as well, but cannot be looked at via a computer program. | will focus on the angle
of inclination with LU.

* Mallon (1952): 22

2 Aussems (2011): 139

B The angle of inclination is not the same as the writing angle or pen angle, of the latter two the upward angle
between the pen and the base line is a part, which is difficult to measure if it at can be measured at all, the
angle of inclination is angle between a shaft of a letter and the baseline, which can be measured. This is more
thoroughly explained by Mark Aussems in his dissertation on page 151.
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Test-case: Lebor na Huidre
Insular Minuscule
Insular minuscule is the script used in LU. It developed from the Latin script brought with

Christianity to Ireland.* Bischoff states:

Fully developed Irish minuscule is a versatile, mostly very angular script, often with
sharp spatulate finials and often with claw-like ductus, which is produced by a special
way of holding the pen. It is often written minutely and was particularly well adapted

to glossing in Irish or in Latin.

It has some distinctive letter forms, a rounded d, a low-set f, a flat-topped g, a p without a

fully closed bow, a r descending on the left below the base line and a low-set s.*°

Lebor na hUidre
Lebor na hUidre or ‘The Book of the Dun Cow’ can currently be found in the Royal Irish

Academy in Dublin with the name MS23 E25. It was written in the 11"-12" century on
vellum, which is parchment made of calfskin. The manuscript contains many well known Old
and Middle Irish texts, such as Serglige Con Culainn, Tain B6 Cuailgne and Fled Bricrend.
There are only sixty-seven leaves left; the manuscript has lost at least sixty-six leaves.'®*’
The last foliation which was made for the Facsimile from 1870 is followed by most
researchers and will be followed here as well. The foliation is one of the reasons that we know
that so approximately half of the manuscript is lost; another reason is that since multiple
scribes refer to a version of Lebar Gabala in LU, which cannot be found in what is now left,
we know that it has been lost completely. LU is the oldest manuscript written completely in
Irish; older manuscripts are partly Irish and partly Latin. For this BA thesis the images of the

manuscript will function as a test-case.

Best and Bergin identify three scribes in LU, namely: A, M and H. Scribe A is the first scribe

and scribe M continued with the work of scribe A. Scribe H is an interpolator, but it is

! Bischoff (1997): 84

> Clemens and Graham (2007): 139

'® Best and Bergin (1929): xxiii. It seems that a calculation error has been made; Best and Bergin state that at
least sixty-six leaves are lost, of which fifty-one before the second foliation and sixteen after that. However,
fifty-one and sixteen gives sixty-seven and not sixty-six.

LU was foliated three times, the first was with the letters of the alphabet, which can be found on the recto
side of the leaves, in the centre of the lower margin. The second foliation was done in the late 16" or early 17"
century and can be found on the recto side of each leaf, in the middle of the upper margin. The last foliation
was done when in 1870 a Facsimile was made and can be found on the recto and verso side of the leaves, in the
upper margin.
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unknown whether he was one or multiple persons.*® Scribe M is the only one of the three for
whom a probable name is known, Mael Muire son of Célechar.® He has made two

probationes pennae stating his name on p.55 and p.70.

In the introduction of edition by Best and Bergin® there is a section about the scribes and
their way of writing, I will use that as the basis to compare my research with. Because | want
to test the computer programs, | need a manuscript of which is known how many scribes
worked on it and someone who has published about that. | will give here a summary of the
descriptions made by Best and Bergin. They describe A as the best penman, his hand is a
careful well-formed book hand, he maintains a more even level of writing than M and H. He
uses the hooked open a as a lowercase letter which is also found in other manuscripts of that
time. Another feature is his tall e, which is found both touching the following letter and free
of the following letter, that both variations are found with one scribe is uncommon. His s with
a subscript i almost form a ligature causing it to look like a h; he also writes out h more often
than the other two scribes. He only uses the 2-shaped r a few times which is uncommon as
well. Best and Bergin describe M as a graceful more pointed hand, not so regular as A. His
letters seem to lean back, which gives a somewhat broken appearance. His tall e are always
looped and touching the following letter, his si are unlike A rarely ligatured and the shafts of
s, r,and f are long and are finished in a hair-stroke. H shows more variety in is writing, it
ranges from a neat and careful script to an untidy scrawl, it has not the lightness and delicacy
of M. His tall e is never looped and does not touch the succeeding letter, that same treatment

can be found with the long s.

Best and Bergin distinguish the hands based on paleographical and codicological findings, so
they do not use language as a differentiator, they focus mainly on the letter-forms and ductus
although both are not named as such. So it seems that the digital measurement will be an

addition and not a repetition of what has been done manually.

% & Neill (2014): 38
'° Best and Bergin (1929): xii, xv
2% Best and Bergin (1929): xiv
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The Images and Preparing Them
The images of Lebor na hUidre and many other manuscripts can be found on the website of

the ISOS project. It would be most useful if these images, as they are currently made for ISOS
are of high enough quality to be used successfully with programs such as GIWIS and
Graphoskop. High quality images are necessary to make sure that the results of the
measurements are reliable; they allow the programs to be more accurate in their
measurements since high resolution images have more pixels which can be measured. In order
to be able to test that, access to the higher resolution pictures is needed. The pictures need to
undergo slight changes before they can be used with GIWIS; these changes can be made
within the program. Since GIMP and Graphoskop cannot be instructed to do measurements by
itself, it does not need grayscale images, but the researcher can use the colored images. For

this test-case of Lebor na Huidre I will use three folios from each hand, namely:

- Hand A, p.3 (Lebor Bretnach) (4.4MB)
- Hand A, p.5 (Amra Choluim Cille) (4.9MB)
- Hand A, p.27 (Fis Adomnan) (5.3MB)

- Hand M, p.17 (D4 bron flatha nime) (4.8MB)
- Hand M, p.67 (Tain B6 Cuailgne) (5MB)
- Hand M, p.99 (Fled Bricrend) (5MB)

- Hand H, p.45 (Serglige Con Culainn) (4.8MB)
- Hand H, p.93 (Togail Bruidne D& Derga) (4.6MB)
- Hand H, p.103 (Fled Bricrend) (4.9MB)

This is based on the division of the folios and their scribes made by Best and Bergin.? |
selected the folios which were of high quality in order to get the best results, with that | do not
mean the quality of the image, but rather the quality of the manuscript itself. For scribe A 12
folios were of high quality, which include page 3 and page 5, page 27 is of lower quality but
is selected because it comes after a section with folios written by M. For scribe M 22 folios
were of high quality, the three selected folios come from different parts of the manuscript.
With scribe H there was less choice, only 7 folios were of high quality; often the ink of H is
faded, which makes taking measurements more difficult. There are also a lot of folios were

both M and H worked on, but they are excluded because the results might get scrambled and

*! Best and Bergin (1929): xx
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GIWIS will not be able to work with it, because it compares one document with another and

makes no comparisons within a document.

14
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Using GIMP
Mark Aussems used GIMP to do the measurements for what he called ‘The Scribal

Fingerprint’.”* GIMP cannot be instructed to do measurements on its own, but it can still be of
aid. GIMP starts up with three windows, one for the images, one with the tools and one for
layers, the latter is not necessary and can therefore be closed. After loading the image into
GIMP the measurements can start. For this | used the complete high quality images from
ISOS with a 200% zoom.

Next step is to determine from which letter, the angle of inclination can be measured. Mark
takes the long s for his research, but since the long s is not very common in Irish manuscripts
this will not work here. A letter is needed which occurs often in the manuscript in order to get
an reliable average on the angle of inclination of a scribe. That is what the goal is: to see
whether the angle of inclination is the same with all the scribe in LU or that differences can be
found. The angle of inclination is generally measured by measuring the angle between the
shaft of an ascending letter and the baseline, therefore a straight shaft is needed. The b, h, I, k
are often used to take these measurements. However the Insular minuscule has also a diagraph
for ar which descends after the base line, so where the shaft of the b and | can be rounded
around the baseline, the shaft of ar will be straight. And since the h and k are used very little

in Insular minuscule, the angle of inclination of the ar will be measured here.

Fight shaft of the symbol for ar

Angle of Inclination

Baseline

©A .E.Romein

For storing and later usage of the data that will be collected a XML file is useful.?® The
storing of the data and how to work with it is not included within this BA Thesis and |
therefore direct the interested reader to Mark Aussems dissertation. Included in Appendix I is
a table with the various angles of inclination that can be found for the shaft of ar for Hand A
p.3, Hand M p.17 and Hand H p.45; the first twenty-five shafts of ar are measured. As can be
seen in Appendix | the average for the angles found in A p.3 and M p.17 are close together,

?2 Aussems (2011): 142
2 Aussems (2011):173
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but A is more concentrate than M; H p.45 has a lower average which sets it apart from A and
M.

17



Using Graphoskop
In order to use Graphoskop, the installation of ImagelJ is needed, once that is done

Graphoskop can be added, while carefully following the instructions®*. After installation the
image can be loaded into ImageJ than go to Analyze > Tools > Graphoskop and select the
image again. Now a new window will open with Graphoskop and the wanted image. It can
handle the high quality images from 1SOS as they are. To start the measurements of the angle
of inclination click on angle écriture®. To measure the angle click on the baseline and drag
upwards while following the shaft. The advantage that Graphoskop has over GIMP is that a
third window is opened where the results of the measurements will be displayed and can be

saved; so for the storing of the results and calculating an average no XML file is needed.

With regard to LU, | measured this time with Graphoskop the first twenty-five angles of
inclination of the shaft of ar. The average angle of inclination is very similar to that which
was calculated with GIMP; the averages which were calculated with Graphoskop were
slightly lower than that of GIMP. Hand A and M are again very similar, while H stands apart.

It seems that Graphoskop can measure with the same precision as GIMP.

?* http://www.palaeographia.org/graphoskop/index.htm > Notice/Instructions (to be found in the left corner of
the page)

% Which literally means ‘writing angle’, but it measures the angle of inclination, not the writing angle or pen
angle which was mentioned before.
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Using GIWIS
The former two programs can be used to make measurement, for example the angle of

inclination as shown previously, GIWIS takes that a step further and is able to compare
different documents with each other. Here 1 will look at the tools called Quill?® and Quill
Hinge, since research has shown that combined with Fraglets the results are promising?’, |
will therefore incorporate Fraglets as well. 1 will let GIWIS compare the nine selected images
based on Quill, Quill Hinge and Fraglets separately and all three combined.

When the high quality images are downloaded from 1SOS, they have a size of approximately
5 MB. These images can be loaded into GIWIS, but while loading the image at this size,
GIWIS no longer responds and needs to be restarted. It does respond with a smaller image
that | used as a test to get the program running, so in order for GIWIS to be able to do its work
the images need to be cropped. For this process | used Paint, a free image and photo editing
program which is installed on all Windows computers. When the pictures of the manuscripts
are taken a ruler is placed beside it, when selecting a piece of the picture the ruler, as a
reference, is kept within the picture. Since the research is about the hand and therefore the
text, selecting pieces with a lot of text is useful, leaving out the blank pieces of vellum. | have
chosen to select the pieces of the pictures all in the same way, in order to create uniformity.
Here | have chosen to select the height of approximately 2230 (the equivalent of 10
centimeters of the ruler) and the width of 4785 pixels, which gives a picture with a size
around 3MB, | have taken the pieces from the middle of the folios. By selecting a piece of the
large image | am cropping the image and not resizing it, in order that the high resolution is

kept.

When the images have the right size, a database in GIWIS can be created via File > New
dataset. GIWIS creates a .gds (GIWIS dataset) file, which is a XML document. After creating
a new dataset, the images can be placed in the dataset via File > Import image; the images are
then placed inside the dataset file that was created previously. After the images are imported
the preprocessing starts. First under General the user can put in general data about the writer,
in this case a scribe, for this research the important information is the name and pen type, but
since we only know one plausible name, | have put in as names Hand A, Hand M, Hand H.

GIWIS will compare all nine images and measure how much they are alike, with 0,0 as a

?® Since the explanation of what Quill exactly does is too complicated to be explained within this BA thesis, |
direct the interested reader to the article by Brink et. al. from 2011: ‘Writer identification using directional ink-
trace width measurements’

%’ Brink, et. al. (2011): 7-8
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complete match. More important is the pen type: this needs to be set on Quill in order for

GIWIS to be able to make its measurements correctly.

The second part is under Preprocessing, which has six steps:

Grayscale, GIWIS works with black and white images because it can then measure
more accurately the width of the ink traces.

Region of interest, since GIWIS makes calculations with regard to written material all
else is not needed. With the images that | selected that meant that the ruler and
unwritten vellum was left out.

Background separation, this is done to separate the ink from the background in order
that GIWIS can perform the measurements more accurately. This step is closely linked
to Otsu, which is the sixth step.

Remove crossed words, since crossed out words does not occur in Irish manuscripts,
this can be left aside.

Unslant, this can be left aside as well, since it is developed to unslant writing which is
deliberately slanted, which is not the case, as far as | know, in Irish manuscripts.

Otsu, since the first step the image is in grayscale and with step three the ink is
separated from the background. With this step the image goes from grayscale to only
black and white; after Grayscale the image consist of multiple shades between black
and white, after Otsu only two shades are left, either black or white. This might gives
problems since now smaller spots, which are not ink might be measured as ink
because Otsu makes them black, which means that it sees them as ink and will
measure them as such. With the background separation a filter is used, which
influences that, so some switching between the Background separation and Otsu is
needed to come up with the correct filter size and an image with the smallest amount

of spots possible.

There will be two images on the screen during the preprocessing; the one on the left is the

original image, the one on the right the adapted image. All the images need to be preprocessed

in this way before the measurements can start.
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When the preprocessing of all the images is finished, it is time for Search, by clicking on
Search a list of tools is shown on the left and on the right the image that was selected at the
top, for example Hand A p.3. The next step is to select the tool that will be used, for example
Quill. After clicking on search, GIWIS will then compare the query image with the other eight
images and order them accordingly. GIWIS gives the results in figures, with zero meaning
that the handwriting of the images is completely alike. The outcome of this experiment can be
found in the Appendices I11-VI.

As can be seen in the results GIWIS places the images of the same scribe close together,
there are to results that stand out namely the closeness of Hand M p.67 to Hand A p.5 and
Hand A p.27 to Hand H p.45. For this experiment to few sample of the hands are put into
GIWIS to give solid explanations for these results, in order to be able to do that a bigger
experiment is needed. However the comparison of the hands seems the concur with the
division of the hands made by Best and Bergin.
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Conclusion
By no means we have to fear the job of the paleographer being taken over by computers in the

near future. However, they will be of great assistance to the paleographer. With this thesis |
examined which computer programs are currently available and how they can be used. The
first problem | encountered was that there is not a uniform list of differentiators which are
used by paleographers when researching an Old Irish manuscript. One of the possible reasons
is perhaps that within Celtic Studies it is the linguist who makes an edition of a text or
manuscript and paleography is done alongside the rest of their research. Or a uniform list of
differentiators was never really needed until one started to look at what a computer can do and
therefore needed to know what was done so far. There is however a list available, which
seems to cover all aspects, that of Elizabeth Duncan. With the aid of computer programs the
following differentiators can be measured: angle of inclination, contrast/weight and modulus.

The focus when testing the computer programs was on the angle of inclination.

The basis of the experiment that followed was Lebor na hUidre and the research about LU
done by Best and Bergin. They identified the hands mostly based on letter-forms; the results
of the experiment were therefore an addition to their arguments instead of a repetition. When
measuring the angle of inclination both GIMP and Graphoskop are adequate, the results are
almost the same. Graphoskop however has the advantage that is collects the results itself and
can calculate an average, while with GIMP the user needs to do that manually. Further
research is needed for Graphoskop in order to see what else it can accomplish and whether it
yields correct results. With GIWIS it went a step further, it was instructed to compare the
hands and showed which hands were closest to one another. For GIWIS a reference on what is
really close and what is not would be useful, in order to get that more input into GIWIS is
needed. For now it is uncertain whether 0,077 is close or 0,110 is just as close?, so the results
are still a little vague, but overall GIWIS seems able to indentify hands correctly.

Overall it was a challenging research because one must not be afraid of all the technical terms
and programs which are used and needs to have some computer skills to get the programs up
and running. However, when they are up and running they give all promising results. In my
opinion the computer programs can be of great assistance to the ‘traditional’ paleographer®
although further testing of the programs is recommended. The paleographers who do research
on Irish manuscripts have one big advantage: the ISOS project, which makes the manuscripts

28 Figures taken from Appendix VI
*° With that | mean the paleographer, who does not use computer programs, but does it research manually.
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digitally available, with images of such high quality and uniformity that they can be used

without dificulty.
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Appendix I (GIMP measuring Angle of Inclination)

__Ap3 |Mpi17 |Hpd45 |
___
76°

___
78°

___
!
___
82°

___
___
3
___
___

90°
___

85,6° 85,7° 79,6°

Appendix Il (Graphoskop measuring Angle of Inclination)

. lAp3 [ MpI17 H p.45
LAVG. [ Y- X
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Appendix 1 (GIWIS measuring with Quill)

-

Ap.5 0,066 -

Ap.27 0,049 0,039 -

M p.17 0,191 0,085 0,096 -

M p.67 0144 005 007 0,037 -

M p.99 0,204 0097 0121 0,035 0,042 -

H p.45 009 0153 0,106 0256 0217 0,297 -

H p.93 0,157 0269 0206 05381 034 0,398 0,069 -

H p.103 0133 0231 0176 035 0306 0349 0085 0,037 -

Query Document 2"% Closest 3" Closest
B /P2 09 ApS(00E)  Hpd500%)

A p.27 (0,039) M p.67 (0,05) A p.3 (0,066)

Ap2T RS(EIe) = [REREE) e (IR ]

M p.99 (0,035) M p.67 (0,037) A p.5 (0,085)

Mes [N R R

M p.99 M p.17 (0,035) M p.67 (0,042) A p.5 (0,097)

5 e e PR I

H p.93 H p.103 (0,037) H p.45 (0,069) Ap.3(0,157)

Heios (SR S R
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Appendix 1V (GIWIS measuring with Quill Hinge)

Quill

-

Ap.J5 0,103 -

Ap.27 0075 0,068 =

M p.17 0284 0,117 0,156 -

M p.67 0208 0077 0113 0,062 -

M p.99 0270 0119 0165 0,064 0,051 -

H p.45 0134 0195 0124 0316 0261 0,297 =

H p.93 0,187 0,338 0239 0518 0438 0398 0,102 -

H p.103 0183 0322 0237 0505 0427 0349 0140 0,072 =

Query Document 2"% Closest 3" Closest

L = I e R eI =

A p.27 (0,068) M p.67 (0,077) A p.3(0,103)

Ap2T RS = [RER) e [ID R ]

M p.67 (0,062) M p.99 (0,064) Ap.5(0,117)

Mes RGN DR R U

M p.99 M p.67 (0,051) M p.17 (0,064) Ap.5 (0,119)

5 PRI 32 R [P

H p.93 H p.103 (0,072) H p.45 (0,102) Ap.3(0,187)

B = e o s
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Appendix V (GIWIS measuring with Fraglets)

_ p.3 --

ApS5 0,177 --

Ap.27 0,208 0,160 -

M p.17 0,314 0,202 0,144 --

M p.67 0,277 0,170 0,147 0,198 -

M p.99 0,262 0,143 0,136 0,165 0,137 --

H p.45 0337 0293 0,209 0301 0,225 0,275 -

H p.93 0,308 0339 0,23 0351 0291 0,311 0,195 --

H p.103 0,248 0313 0,224 0,328 0303 0325 0,218 0,200 --

Query Document 2"% Closest 3" Closest
B /o) Ap270208)  Hpl03(0.248)

M p.99 (0,143) A p.27 (0,160) M p.67 (0,170)

Ap2T DGR R O [P ]

A p.27 (0,144) M p.99 (0,165) M p.67 (0,198)

Mes  [CERICEEU R UG R L O R

M p.99 A .27 (0,136) M p.67 (0,137) Ap.5 (0,143)

5 FIPERICRE (27 ) S RO ]

H p.93 H p.45 (0,195) H p.103 (0,200) A p.27 (0,235)

Hpl0s [ G G I L
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Appendix VI (GIWIS measuring Quill, Quill Hinge and Fraglets together)

Fraglets,
Quill,
QuillHinge|Ap.3 |Ap5 |Ap.27 |Mp.l7 (Mp.67 (Mp.99 |Hp.45 |Hp.93 |Hp.103

Ap.J5 0,115 -

Ap.27 0,110 0,089 =

M p.17 0263 0,134 0,132 -

M p.67 0210 0,099 0,110 0,099 =

M p.99 0245 0120 0141 0089 0,077 -

H p.45 0189 0214 0146 0291 0234 0,304 =

H p.93 0218 0315 0227 0417 0356 0400 0,122 -

H p.103 0188 0289 0212 0394 0345 0,381 0,148 0,103 =

Query Document 2"% Closest 3" Closest
R /-2 C10  ApS(OAS)  Hplo3(isg)

A p.27 (0,089) M p.67 (0,099) Ap.3(0,115)

R /o 0% Aps(OL0)  Mp6TOL0)
M p.99 (0,089) M p.67 (0,099) A p.27 (0,132)
R Ve 007D Mpl7(00%9)  ApS(00%)

M p.99 M p.67 (0,077) M p.17 (0,089) A p.5 (0,120)

5 N O SN

H p.93 H p.103 (0,103) H p.45 (0,122) Ap.3(0,218)

Heios (SRS R S R
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Abbreviations

GIMP
GIWIS
ISOS

LU
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GNU Image Manipulation Program
Groningen Intelligent Writer Identification System
Irish Script On Screen

Lebor na hUidre



